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 Installation Guide and System Requirements 
 
Arrisca Version 4 : FlexProfessional™ is provided on an installation CD. 
If you have access to network installation, please contact your network 
administrator for installation instructions. 
 
System requirements 
Operating System: Microsoft Windows 7. 
Microsoft Excel®: Office 2010 and 2013. 
Microsoft Project 2010 
 
 
FlexProfessional™ requires about 100MB of free hard disk space. 
There are no other specific hardware requirements. 
 
Installation 
Insert the installation CD in your CD drive. 
Run file [CD]:\Setup.exe 
Follow the on screen instructions. 
The Licence key code can be found in licence agreement supplied with the CD or 
via email.   
Microsoft .Net© may need be installed to ensure full functionally  
Ensure that UAC (user access control) is set to off/never notify 
You must restart your PC after installation to complete the process. 
 
The installer places an application icon onto the desktop which you will see after 
installation. This icon is used to start the application and load the workbook. 
 

 

 The software includes “factory set” terminology that relates to a ISO 
15-288 organisation  such as the MoD, it also has pre-set ‘risk category’s’ for 
risk identification/classification, you are advised to check your organisation 
procedures and policy’s to ensure that the terminology is appropriate. 
 
All of the pre-settings can be ‘User’ adjusted to meet your requirements see 
section 9 
 
 

: There are NO adjustments required for Arrisca to interact with MS 
Project. 
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 Launch the application & attach a Project Plan 
 
The application is launched from an icon on the desktop, or if a .paf (project 
assessment file has been created, by double-clicking the .paf file itself. 
 

1.1 Click once on the ‘Arrisca 4.0’ application icon on the desktop. 

 

1.2 The ”Select Application to Flex” start screen will be displayed  

 Select Project 

  

1.3 The application start screen will be displayed.  

 

 
 

Select the option you require: 

 Open new MS Project – Browse for a project file to perform an analysis 

 Open Arrisca PAF file – Load a previous analysis as a complete package 

 Open last assessment – Return to the last activity-state of the application 

 Recover post-error – for use in case of an undesired application failure 
 

Select the project file you wish to analyse and click Open. 

  The project will automatically open in its own window in addition to 
the Arrisca Analyser application 
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 Application Navigation 
The FlexPro application is controlled using an intuitive combination of View 
Panes, Menus, Function Tabs, Feature Bars and Control Buttons.  
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2.1 Start Control function tab 

 
The Start Analysis Function Tab displays and manages controls related to the 
driver analysis itself. It can be accessed at any time from its Function Tab. 
 
 
 

2.2 Feature Bar - Analysis Control 

The Feature Bar contains function-specific controls and information pertaining to 
the attached workbook and Driver Analysis Control: 

 
 
 

2.3 Select Task 

 
 

 All Tasks- will be included in analysis 

 Summary Tasks- Will only include summary tasks in analysis 

 Non Summary Tasks-  

 Zero duration – Use only tasks that has a duration  above zero 

 None- use no tasks 

2.4 Options 
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2.4.1 Change Sensitivity multiplier values 

This command allows you to select Driver Analysis utility options: 
 
 

 Change Sensitivity Multiplier values – allows modification of the upper 
and lower multiplier limits that are used during the sensitivity analysis 
itself. This will display a pop-up window that will allow you to enter 
new flex limits. The default values are -10% & +50% of each task  

 

 
 

: The actual effect of each input, or Driver, is calculated from the 
Cumulative Effect of both the increase and reduction in the value of the finish 
date during analysis, measured in days. The resulting effect may often appear 
to be greater than expected due to weekend time in MSP. 
 

2.4.2 Show Project during analysis  

 Show Project during analysis – select this option to display the 
workbook during the Driver Analysis so you can see the data being 
flexed.  

 

 The project plan is normally hidden during the Driver Analysis – 
visibility of the plan slows the analysis down considerably. 
This function also facilitates the ability to view the project during Monte Carlo 
Simulation of risks, opportunities and uncertainty if it is selected prior to 
running an analysis from the Analysis & Reports tab. 
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 Change Target Values 
Change Target Values – provides the facility to present additional bars on the S-
curve reports to represent the desired outcome, which may be different from the 
deterministic or other confidence-related values. 
Click on the salmon pink fields that display the data on the Driver Analysis tab. 
 

 
 
New target Finish Date and duration time can change via the popup menu 
results are displayed in the project information panel 
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2.4.3 Select Key Outputs function 

This function is embedded in project Information panel as Change. 

 
If the task displayed in the Main Project Information Panel (above) is not the task 
you want to analyse for sensitivity or to measure risk against, click the Change 
key output task button in project information panel. A window will appear with 
a full list of the project’s tasks which will allow you to reselect your Key Output 
Task. 

 
 
Note: If you have previously run an analysis of any sort in the Arrisca application 
against the original Key Output Task you will be prompted to re-run the analysis 
as the Key Output Task has changed and all current analysis results are invalid. 
 

 



Arrisca for MS Project™  
 

Software Version 4– FEB 2015 Page 12 

   

2.4.4 This prominent green GO button in the Project Information Panel starts 
the Driver Analysis. 

 

 
To start the Driver analysis: 
1. Click once on the green GO button. The Project is hidden from view (unless 

the option to ‘show project during analysis’ option was selected) and a 
progress indicator is displayed to show the status. 

2. During analysis the button changes to a red Stop button. Click this to cancel. 
3. When the analysis is complete the Sensitivity Function Tab changes colour to 

green. 
 
 
 

: The Driver Analysis is completely unconnected to the Monte Carlo 
Simulation and Analysis function of the Arrisca software. It is a much faster 
method of ascertaining key tasks to the project prior to any stochastic process. 
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 Sensitivity Panel 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
  

View Panels are dynamic panes that contain 
lists and control windows. Both the main 
application window and all panels are resizable 
and have a ‘size-memory’. 
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3.1 Sensitivity Function Tabs 

3.1.1 View 

 
 

• Top ‘N’ inputs 
• Ranked N + above 
• Above a Percentage 
• Working inputs   
• Non- working inputs 
• With Positive effect 
• With Negative effect 
• Above a certain value 
• All 
• Hidden 
• Driver category 

o Filter 
o Remove Filter 

 Tornado 
o Relative 
o Absolute 

 
 
 

3.1.2 Re-analyse Project 

 
This function allows to view the results of any “flexing” in MS Project 
 

3.1.3 Export Command 

         
This allows the sensitivity analyse to be exported to the desired MS tool 
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3.2 Options command 

 
As default the watch panel contains the “target cell”, additional cells can be 
added via the ‘Add Output cell(s) to watch window ‘command.  
 
The Hide command enable single or multiple driver rows to be removed from the 
viewing pane; their effect on the sensitivity analyse is not affected.  
To bring hidden rows into view select the View tab, Hidden option, chose the 
rows then either select Unhide from the Options tab or right click the mouse and 
select “unhide” from the “Driver Actions” option 
 
The Apply command allows you to decide where comments and or Names that 
are entered in the Drivers Details Panel are displayed after they are Saved via 
the Driver Details panel  
Options:   

 All Change every row 

 Listed Change listed rows 

 Select Change selected rows 
 
    

3.2.1    3 PE (Point Estimating) 

3.2.1.1 Generate 3 Point estimates 

 
This command will allow you adjust the driver set by generating 3 point 
estimates, results can be viewed in the Uncertainty section. 
  

 
. Method:  

 Select rows to be adjusted, use ctrl+Click to select several rows 
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 Select 3PE Generate 3 Point Estimate, chose distribution shape and 
required values for Min, Most Likey & Max, 

 press Generate button 

3.2.2 Show drivers in Uncertainty  

This command allows you transfer selected drivers to the Uncertainty Register 
such that they may have Uncertainty Assessments made on them. 
 
To transfer cells to the Uncertainty Register: 

 Select the Drivers you want to transfer to the Uncertainty Register 

 Click on the 3 PE tab > select Show Drivers in Uncertainty Tab command. 

 A confirmation message is displayed. Click OK to finish operation. 
 

The selected cells are displayed in the Uncertainty Drivers List on the 
Uncertainty Function Tab. Their shapes are highlighted in red to indicate no 
assessment has yet been made 
 
 

3.2.3 Apply Flex Values to Uncertainty 

 
Uncertainty may be added by recording the manipulation of the Sensitivity 
Drivers on the Sensitivity 3 PE Function Tab.  
To add Uncertainty from manipulation of the Sensitivity Drivers: 

1. Select the Drivers (cells displayed) to be flexed and added to the 
Uncertainty List 

2. Set Likely values: This must done first 
i.Use either the Input Control Slider or the + or - Flex Buttons to 

manipulate the selected drivers to a desired state which 
represents a set of Likely Uncertainty values 

ii.Right click the mouse select Apply to Cost model (cell ref)> 
select As 3PE Likely 

iii.A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  

iv.The Driver cells have been added to the Uncertainty Drivers List 
on the Uncertainty Function Tab with a Constant shape of 
the value set by the flex manipulation 

3.  Set Minimum values: 
i.Use either the Input Control Slider or the + or - Flex Buttons to 

manipulate the selected drivers to a desired state which 
represents a set of Minimum Uncertainty values 

ii.Right click the mouse select Apply to Cost model (cell ref)> 
select As 3PE Minimum 

iii.A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  
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iv.The Minimum values have been added to the parameters on the 
Uncertainty Drivers List on the Uncertainty Function Tab. 
The shape is now indeterminate and is highlighted in red. 

4. Set Maximum values: 
i.Use either the Input Flex Control Slider or the + or - Flex 

Buttons to manipulate the selected drivers to a desired state 
which represents a set of Maximum Uncertainty values 

ii.Right click the mouse select Apply to Cost model (cell ref)> 
select As 3PE Maximum 

iii.A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  

iv.The Maximum values have been added to the parameters on the 
Uncertainty Drivers List on the Uncertainty Function Tab. 
The shape is now Triangular and the assessment is complete. 
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3.3 Risk 

This command enables either the inclusion of pre-defined risks or the ability to 
create new risks, both risk details and metadata can be captured, the metadata 
elements can be user defined allowing user selection from a dropdown menu. 
Once the risk detail is saved via the save and close button, you will be prompted 
to select the drivers that are affected by the risk.  
 

 
Add to selected drivers method: 

1. Select Driver(s) using crtl for multiple choice select Risk>Add to selected 
drivers from the sensitivity function tab. 

2. A popup “Select Risk” menu will appear either selected a listed risk or 
press New. 

3. If New was selected a Popup form appears, this is in two parts: 
a. Definition – You are required to name and describe the risk and 

state the Risk Code and Risk manager. If Blanket Probability is 
chosen you must input a probability factor.  

b. Meta Data - will require you to fill the relative metadata via 
dropdown menus. These dropdown menus can be update by the 
user to reflect your Organisations policy see 12.1 for details. 
Alternatively menu can be change using the “+” alongside the 
dropdown menu box.  

4. Press Save and Close a new popup form will appear that requires you to 
Define selected Driver Impacts  

5. The affected driver is displayed in “target” area of the popup form. 
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6. Set Probability: 
a. Select either of the Qualitative or Quantitative options in 

probability sub panel.  
i. Qualitative: Select the desired Probability Level from the 

drop-down list that appears to the right of the option; 
ii. Quantitative: Type in the desired Probability value ( an 

integer between 0 and 100) in the field that appears to the 
right of the option. 

 
7. Set Impact (the impact of the risk not to be confused with the 

uncertainty estimate): 
a. Select either of the Qualitative or Quantitative options in the 

Assessment sun panel.  
i. Qualitative:  

1. Select either Relative or Absolute levels; 
2. the desired Impact Level from the drop-down list that 

appears to the right of the option; 
ii. Quantitative: 

1.  Select the desired Shape from the drop-down list that 
appears to the right of the option; 

iii. Type in the desired Impact Values (min, likely, max, etc) in 
the fields that appear underneath the shape drop-down. 

8. Click Save a popup message will appear to give progress press OK. 
 
Add to All 

1. Select  Risk>Add to ALL from the sensitivity function tab. 
2. A popup “Select Risk” menu will appear either selected a listed risk or 

press New. 
3. If New was selected a Popup form appears, this is in two parts: 

a. Definition – You are required to name and describe the risk and 
state the Risk Code and Risk manager. If Blanket Probability is 
chosen you must input a probability factor.  

b. Meta Data - will require you to fill the relative metadata via 
dropdown menus. These dropdown menus can be update by the 
user to reflect your Organisations policy see 9.1.2.8 for details. 

4. Press Save and Close a new popup form will appear that requires you to 
Define selected Driver Impacts  

5. The affected driver is displayed as blank as all drivers are affected in the 
“target” area of the popup form. 

6. Set Probability: 
a. Select either of the Qualitative or Quantitative options in 

probability sub panel.  
i. Qualitative: Select the desired Probability Level from the 

drop-down list that appears to the right of the option; 
ii. Quantitative: Type in the desired Probability value ( an 

integer between 0 and 100) in the field that appears to the 
right of the option. 

7. Set Impact (the impact of the risk not to be confused with the 
uncertainty estimate): 

a. Select either of the Qualitative or Quantitative options in the 
Assessment sun panel.  

i. Qualitative:  
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1. Select either Relative or Absolute levels; 
2. the desired Impact Level from the drop-down list that 

appears to the right of the option; 
ii. Quantitative: 

1.  Select the desired Shape from the drop-down list that 
appears to the right of the option; 

iii. Type in the desired Impact Values (min, likely, max, etc) in 
the fields that appear underneath the shape drop-down. 

8. Click Save a popup message will appear to give progress press OK. 
 
 

Blanket Probability will take presentence over individual risk settings if 
two or more risks have an impact on a selected cell 
 

 
 Relative will produce values for min. most likely and max (3PE) based on 

the deterministic value used in the model. 

 Absolute option will add the deterministic value to the pre-determined 3 
PE defined by “User”. This option is best suited to “Design to cost” 
modelling when detailed risk impact information is limited. 

 
 
. 
 

3.3.1 Reset all drivers command   

This command allows you reset any changes that have been made to Driver cells. 
 
To reset Driver cells to their original (deterministic Excel) values: 
1. Click once on the Reset all drivers command. 
2. All Drivers will be returned to their original values.  
 

 Comments and Names cannot be reset 
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3.4 Sensitivity drivers panel 

  

 

The columns are used to summarise the analysis results and subsequent flexing. 
To sort the data by a column in descending order click on the column title bar 
text. A second click on the column title bar text will sort in ascending order. 

 

3.4.1 Analysis Results columns 

These columns are used to display deterministic (original) workbook input 
data and the results of the sensitivity analysis once completed. 

A No.   

 Displays the unique line number of the driver list.  

B Rank 
Displays the Driver ranking sorted by decreasing effect. The most influential 
Driver is ranked number 1. All drivers below this have less effect for a given 
amount of flex than this driver. 

C Task Description 
Information taken from Project workbook Format 
D UDI 

Task unique identification 

E Duration  

Task duration 

F Outcome Effect 

Displays the amount the Key Output Cell is affected by the sensitivity analysis at 
the settings defined in the Analysis Multipliers control. The column heading 
displays the cumulative sensitivity value used in analysis.  
Note: If the analysis was executed at the default of +10% then the column 

A 

B 

C 

D 

E 

F 

G 

H 

I 

J 

K 

L 

M 
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heading will read ‘Effect @ 10%’. 
 

G Effect at 90 and 110% / Tornado Bars 

Displays the effect of the cell at the given flex value as a percentage of the Key 
Output Cell value. i.e. If the KOC value is 1000 and the ‘Sensitivity @ 10%’ is 100 
(from the previous column) then the Effect% will be 10. 
The background displays a graphical representation of the effect of the Drivers 
list on the Key Output Cell. The tornado bar is colourised to indicate polarity of 
effect: 

Red = Direct: KOC value increases as Driver cell value increases. 

Green = Inverse: KOC value decreases as Driver cell value increases. 

The scale view of the Tornado bars can be changed from Relative to Absolute by 
using the Tornado command on the Feature Bar. 
 

3.4.2 Flex Control columns 

These columns are used to dynamically flex and manipulate the workbook input 
data and display the flexed data values. During manipulation the Project 
workbook is manipulated and is updated with the flexed input values so you can 
see the effects of the manipulation on the workbook. These changes are not 
automatically saved but this can be done by using the Save as menu item in MS 
Project. 

 

H– (minus character) increment control 
This control is used to reduce the Driver input value by 1% increments 
Click on the minus character to reduce the input cell value by 1% per click. The 
control is colourised to indicate the polarity of the resulting effect on the Key 
Output Cell as follows: 
Red = KOC value increased as a result of the input cell decrease (denoting an 
inverse relationship). 
Green = The KOC value decreased as a result of the input cell decrease (denoting 
a direct relationship). 
I Delta 
displays the percentage delta value in percentage terms of the Driver input cell 
if manipulated. If the cell has not been manipulated the field displays zero 
value. 
J +  (plus character) increment control 
This control is used to increase the Driver input value by 1% increments 
Click on the minus character to increase the input cell value by 1% per click. The 
control is colourised to indicate the polarity of the resulting effect on the Key 
Output Cell as follows: 
Red = KOC value decreased as a result of the input cell increase (denoting an 
inverse relationship). 
Green = The KOC value increased as a result of the input cell increase (denoting 
a direct relationship). 
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K Flexed value 
Displays the new (flexed) value of the Driver input cell if manipulated. If the cell 
has not been manipulated the field displays the original cell value. 

 

: If you want to set the Driver input value to a specific value 
rather than use the plus / minus incremental controls you can select 
this field and type in the desired value. Press the Enter key on your 
keyboard to update the value. 

3.4.3 Information Columns 
 

L Category 

 Displays the assigned identification; this should align with your 
organisations process or policy on identifying risk and uncertainty. 

  

M Comments 
Displays the user input comments 
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3.5 Input Control Slider Panel 

 
 
This panel allows you to flex multiple rows so that the change the “Key Output 
Cell” (KOC) can be calculated.  
Use the ‘shift’ or ‘Ctrl’ keys to select multiple Drivers on the Sensitivity Drivers 
panel and then drag the Flex Control Slider to manipulate the inputs as a group. 
The inputs will be manipulated by the same percentage of their original values. 
The resulting effect on the KOC is displayed in the Watch Output Cells panel. 
Subsequent groups of inputs may then be selected and flexed to build-up a 
scenario.  
 
For example, a group of durations may be selected and manipulated using the 
slider to simulate an overall increase in the time required to perform tasks. Once 
this effect has been applied, a group of rates or overheads may be adjusted 
downward to reflect the changes possible as a result of more hours and the 
overall effect will be displayed in the Watch Output Cells panel. 
 

: The Project workbook will be dynamically updated with the flexed 
input data. You can save your scenarios either by saving the workbook as a 
different filename or by over-writing the original workbook. 
 

: The application has already made a backup of the original workbook in 
the source folder with a time and date extension that can be kept or deleted on 
close. 
The slider control allows the flexure of multiple Driver inputs simultaneously. 
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3.6 Watch Output Cells 

The Watch Output Cells panel allows the monitoring of multiple workbook 
outputs simultaneously as the Driver Inputs are manipulated. Initially, only the 
Key Output Cell is loaded as the first entry to this control and can be identified 
by the title of the output response window (for example [key output cell = 
‘abc’]).  As the inputs are manipulated and the KOC is affected the background 
colour will change to Red or Green as the KOC increases or decreases in value 
respectively. 
 

 
 

3.6.1 Add Output to watch list 

Selecting the “Add” option will display a popup menu listing all the task from the 
Project, either select a single task by clicking the row multiple additions can be 
selected by crtl+click to select rows 
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3.7 Sensitivity Driver panel contextual menu (right-click)  

 

 

3.7.1 Driver selected 

Reset – returns this cell to its original Project values comments and names 
added are not affected. 

3.7.2 Apply selected value to 

This command transfers the current cell value to the Uncertainty assessment, 
full flex instruction are detailed in 5.1.5.1; options are available: 
 

 Minimum – applies current flex value to Uncertainty minimum value 

 Likely – applies current flex value to Uncertainty likely value 

 Maximum – applies current flex value to Uncertainty maximum value 

3.7.3 Show selected in uncertainty  

This command provides a shortcut method that bypasses the Risk feature covered 
in 5.1.6 that is it enables you to transfers the current cell to the Uncertainty 
Drivers list Add selected drivers to Risk 
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 Uncertainty Tab 

 
The main window on the Uncertainty tab displays a summary of the Uncertainty 
parameters beneath the Features Bar with its Uncertainty-related controls. 
Each row in the list of Uncertainty Drivers pertains to one input cell in the 
attached Excel workbook and summarises the applied Uncertainty assessment. 
 
Each column contains a parameter pertaining specifically to the cell selected. 
The Uncertainty Drivers list may be sorted by any column alphanumerically 
ascending or descending by clicking on the column header description title. 
 
Column headings are: 

 Metadata:  
o Name of Input Task: If there is a Task name in MS Project 
o Worksheet: Location of the Task in the Project Workbook 
o Task: Location of the Task in the project Worksheet 
o Input Task Value: Single-point (constant) value from MS Project 

 Assessment Parameters:  
o Level: Qualitative level assessment (H, M, L, etc.) 
o Shape: Quantitative distribution type (Uniform, Triangular, etc) 
o Min: Quantitative lowest possible value for 3PE 
o Likely: Quantitative most likely value for 3PE  
o Max: Quantitative highest possible value for 3PE  

 Comments: Text field for capturing notes and assumptions re. Task 
 

 Uncertainty may be added in one of three ways: 

 Add by manual entry 

 Import from Tasks in the attached Project workbook 

 Import from a separate Uncertainty Register 

 Generate Uncertainty by Sensitivity Driver manipulation 

Associated Risk 
/ Correlation 

Data 

Edit 
Parameter

s 

Parameter 
summary 

Info. 

     Assessment 

           Metadata        
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4.1 View Function 

 

4.2 Add Uncertainty by manual entry 

To add uncertainty by manually selecting cells from the attached Project 
workbook: 
1. Add cells to be assessed to the Uncertainty Drivers List 
2. Edit Uncertainty assessment parameters 

4.2.1 Add cells to be assessed to Uncertainty Drivers List 

To add uncertainty by manually selecting cells from the attached workbook: 

 Click once on the Data tab on the Uncertainty Feature Bar 

 Select Add Tasks from the drop-down list. The Task-selector will be 
displayed: 

 
 

 

 Select the tasks to which you want to add uncertainty parameters. Use the 
Ctrl or Shift keys to select multiple tasks at the same time. 
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 Click OK. A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete the operation. 

 The tasks are now displayed in the main Uncertainty Drivers pane with 
their names, deterministic values. Note that the shape column is 
highlighted in red denoting that although the cell is available for 
uncertainty assessment it currently has no parameters assigned to it. The 
tasks are now ready for parameterisation and assessment as described 
later in this section. 

4.3 Apply or edit QUALitative Assessment Parameters 

The application provides a unique ability to assign Uncertainty by applying a 
qualitative level to the task. Qualitative assessment parameters are described in 
detail in Section 7. When the qualitative level is applied to a task the 
quantitative parameters, such as a three-point estimate, are automatically and 
dynamically calculated relative to the cell’s deterministic duration. 
 
To apply a qualitative Uncertainty assessment to a single task: 

 Select the task row to which you wish to apply the assessment level 

 In the Uncertainty parameter pane, select the Qualitative button 

 In the type selector box, select either Relative or Absolute levels 

 Select the level you wish to apply from the level drop-down box 

 Click Save. The assessment is applied and the Level is displayed in the 
main Uncertainty Drivers list. 

 

 
 
To apply a qualitative level to multiple tasks at the same time: 

 Hold down the Ctrl key and click once on each row you want to select 

 Repeat the qualitative level selection process above and click Save. 
The assessment level is applied to each of the selected cells and the Level is 
displayed for each selected cell in the main Uncertainty Drivers list. 

4.4 Apply or edit QUANTitative Assessment Parameters 

Quantitative Uncertainty assessments may be made using several standard input 
distributions that are listed and described fully in Section 8. 
 
To apply a quantitative Uncertainty assessment to a single task: 

 Select the task row to which you wish to apply the assessment level 

 In the Uncertainty parameter pane, select the Quantitative button 

 Select the distribution Shape you wish to apply from the Shape drop-down 

 Type in the Minimum, Likely and Maximum values you wish to apply (the  
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 Click Save. The assessment is applied and the parameters are displayed in 
the main Uncertainty Drivers list. 
 

 
 
To apply quantitative parameters to multiple tasks at the same time: 

 Hold down the Ctrl key and click once on each row you want to select 

 Repeat the qualitative level selection process above and click Save. 
The assessment parameters are applied to each of the selected tasks and are 
displayed for each selected task in the main Uncertainty Drivers list. 
 

: The total number of Uncertainty Driver cells is displayed above the 
summary pane underneath the Feature Bar: 

 

4.5 Data 

 

4.5.1 Add Tasks 

To add uncertainty by manually selecting cells from the attached workbook: 

 Click once on the Data tab on the Uncertainty Feature Bar 

 Select Add Tasks from the displayed cell-selector.: 
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 Select the cells to which you want to add uncertainty parameters. The cell 
locations or ranges will be displayed in the cell-selector window. Click OK. 
 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. 

 The cells are now displayed in the main Uncertainty Drivers pane with 
their names, locations and deterministic values. Note that the shape 
column is highlighted in red denoting that although the cell is available for 
uncertainty assessment it currently has no parameters assigned to it. 
 

4.6 Import parameters 

 

4.6.1 From data in this project 

: First ensure that the Project workbook has 4 columns headed 
Duration 1,2 & 3 with Duration 1 = Minimum estimate, Duration 2 = 
Most Likely, Duration 3= Max estimate and Text 30= Shape in 
accordance with APM guidance. 
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To grab 3-point estimate uncertainty input data from the attached workbook: 

 Click once on the Data control on the Uncertainty Tab > Feature Bar 

 Select the Import parameters > From data in this Project option. The 
input dialog appears: 

  

 
 

 Only one format for the Columns.. If you have defined the distribution 
shape by typing its initial to the left of the max value select the Include 
Shape box. 

 Once you have selected your options click Apply. 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. The selected 
cells are added to the Uncertainty list, the 3PE parameters are applied 
and the new selections are displayed in the main Uncertainty Drivers list. 

 
 

4.6.2 From external workbook (.xls) 

: Excel workbook must be in the template format, please check before 
proceeding. 
 
 
To grab 3-point estimate uncertainty input data from an Excel workbook: 

 Click once on the Data control on the Uncertainty Tab > Feature Bar 

 Select Import Parameters>From external workbook option. The file 
manager will appear 
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 The application expects the min and max values to be adjacent to the 
task ID so you don’t have to select them all, as shown in the graphic below. 
 
 

4.6.3 Generate an Uncertainty Register import template 

The application contains a function to generate for the user a new workbook 
with a pre-configured risk register import template for easy population. 
 
To generate the risk register import template in new workbook: 
 

 Click once on the Data control on the Uncertainty  Tab Feature Bar 

 Select Import Parameters then Generate external register (.xls) 
template option. 

 A new Excel workbook will be created which contains the pre-configured 
template layout. Populate the template with your data and be sure to 
save the file. 

 

4.6.4 Export parameters 

 

4.6.4.1 Paste to this Project 

 
The ability to export the uncertainty parameters to the attached project using a 
paste function provides the ability to populate the project file with data values 
with minimal effort. To export Uncertainty to the attached project: 

 Click once on Uncertainty > Export Parameters > Paste to this Project  
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The Paste back control box is presented, as below: 
 

 
 
 

 If required select Also include shape (will paste back the distribution 
shape into Text30) 

 Click Paste to complete the operation. 

using the  Duration 1,2 & 3 columns with Duration 1 = Minimum 
estimate, Duration 2 = Most Likely, Duration 3= Max estimate and Text 30= 
Shape 

 

4.6.4.2 Export To External Workbook as an uncertainty register 

To export Uncertainty to an external register in a new Excel workbook: 

 Click once on the Data control on the Uncertainty Tab Feature Bar 

 Select Export Parameters then To external register (.xls) option.  

 Select the file name and location in the displayed file-browser window  

 Click Save. 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. 

 
The Uncertainty parameters are exported in the following format: 
 

 
The parameters may be edited, extended or reduced as required in Excel and 
then re-imported into the application using the Uncertainty Tab  Feature Bar 
Data > Import Parameters  > From external register (.xls) control described in 
Section 6.5.3 
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4.6.4.3  Over write Deterministic  

This will allow you to over write existing values with adjusted values. There are 
two main options that is All or Selected 

 If you have decided to use Selected it necessary to slect those item first 
using the ctrl key and left click. 

 Click once on the Data control on the Uncertainty Tab Feature Bar 

 Select Export Parameters then Overwrite deterministic option.  

 Using the popup Overwrite deterministic options, select the values you 
wish replace. 

 Chose to include comments by ticking Add Comment tick box 

 Chose to include Polarity (the impact of the uncertainty) by ticking the 
tick box. 

 Press Paste to complete 

 Popup message box will inform of progress.  
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4.6.4.4 Remove Uncertainty 

Uncertainty may be removed by one of two methods: 

 All 

 Selected rows only 
 
To remove All uncertainty assessments and clear the Uncertainty Driver list: 

 Click once on the Data on the Uncertainty Tab  Feature Bar then select 
Remove uncertainty  

 Select the All option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 

 Select the rows representing the cells you want to remove from the 
Uncertainty Drivers list 

 Click once on the Data on the Uncertainty Tab Feature Bar 

 Select the Remove uncertainty then Selected rows option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

4.6.5 Activate Uncertainty 

To deactivate uncertainty assessments and clear the Uncertainty Driver list: 

 Click once on the Data on the Uncertainty Tab  Feature Bar then select 
Activate uncertainty  

 Select the All option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. View “Active” column to confirm operation. 

 
To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 

 Select the rows representing the cells you want to remove from the 
Uncertainty Drivers list 

 Click once on the Data on the Uncertainty Tab Feature Bar 

 Select the Activate uncertainty then Selected rows option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. View “Active” column to confirm operation. 

 

4.6.6 Deactivate Uncertainty 

To deactivate uncertainty assessments and clear the Uncertainty Driver list: 

 Click once on the Data on the Uncertainty Tab  Feature Bar then select 
Deactivate uncertainty  

 Select the All option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. View “Active” column to confirm operation. 

 
To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 



Arrisca for MS Project™  
 

Software Version 4– FEB 2015 Page 37 

 Select the rows representing the cells you want to remove from the 
Uncertainty Drivers list 

 Click once on the Data on the Uncertainty Tab Feature Bar 

 Select the Deactivate uncertainty then Selected rows option 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. View “Active” column to confirm operation. 
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 Correlation  
Correlation between any uncertainty inputs can easily be applied from the 
Uncertainty Drivers List and managed from the Associated Correlations box. 
 

Correlation is the expression of interaction between variables. 
•  Correlation is used to describe the derivative effect of the variation of 

nominated ‘lead’ elements on ‘dependent’ elements during analysis. 
•  Correlation can be used to make variables ‘follow’ or ‘repel’ each other to a 

degree specified by what is called the Coefficient of Correlation. 
•  The relationship between the variables may be described as either Direct or 

Inverse depending on the nature of effect. 

5.1 Add correlation to Uncertainty Driver cells 

In the Uncertainty Drivers list on the Uncertainty Function Tab: 

 Select the Uncertainty Driver rows you wish to correlate using the Ctrl key 

 Right-click once on one of the selected cells and a menu appears 

 Select the Add Correlation with uncertainty of ‘Cell x’ option 
 

 
 

 
 
 

 The Correlation dialog box will appear. From here you can change either the 
cells to be correlated or the degree of correlation to be applied. 
 

 Using the Change button select the desired cells and degree of correlation 
selected, click once on the Apply button to commit the correlation to the 
simulation. 

Risk & 
Correlation 
Panel  

Right Click menu  

 Correlation 

dialog box  

Task 

List 
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5.2 Alternative method (short cut) 

 In the viewing panel select the rows you which to correlate using 
crtl+click. 

 Right and select Correlation option this will take you to the dialog box 
where the correlation value can applied. 

  
The Associated Correlations panel will be populated.  

Parameter Inputs: 
•  Lead variable 
•  Tracking variable (s) 
•  Correlation coefficient (value = -100% through 100%) 
•  Any degree of Direct or Inverse correlation can be specified, with the 

greatest effects at the +100%/-100% limits. 

5.3 Correlation Tab 

 

 

5.3.1 Show All 

This function control what is displayed in Risk/Correlation panel (btm. right hand 
of screen) 

 Select Correlation from Uncertainty function tab 

 Select Show All to display all the items that are correlated. 

5.3.2 Remove All 

This function control what is displayed in Risk/Correlation panel (btm. right hand 
of screen). 

 Select Correlation from Uncertainty function tab 

 Select Remove All to remove correlated items from display. 

5.3.3 Remove Selected 

This function removes selected items from view. 

 Using Ctrl key and left click select items to be removed. 

 Select Correlation from Uncertainty function tab 

 Select Remove Selected to remove correlated items from display. 

5.3.4 Export 

Will export the correlation data to an Excel workbook 
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 Select Correlation from Uncertainty function tab 

 Select Export, you be asked to Name the file then press Save, this will 
create a new workbook in the format shown below. Remember to fill in 
Excel with metadata and Save. 
 

 
 

5.3.5 Import 

Will Import Correlation data from an Excel workbook 

 Select Correlation from Uncertainty function tab 

 Select Import> select file from Import manager. 
 

: file must be in the format shown above.  
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5.4 Get 3PE from data in the project 

 
 
3-Point Estimates can be held in the MS Project file in accordance with APM 
guidelines. The data is held in the following fields: 

 Duration 1: Minimum (Optimistic) value 

 Duration 2: Most Likely (Expected) value 

 Duration 3: Maximum (Pessimistic) value 
 
To import 3-point estimate uncertainty input data from the attached project: 

 From the Uncertainty control click Get 3PE from project. The input 
dialog appears: 
 

 
 
 

a. Select the Also Include Shape option if the distribution shape has 
been defined. This is held in the MSP field Text 30. 

b. Select the Also add as Key Result option if you want to 
automatically add the task to the list of Key Results available for 
statistical reporting. 

c. Select the Ignore Zeros option if you want to automatically reject 
all tasks which have zero duration – this keeps the Uncertainty list 
cleaner. 

 Click Apply. The application imports the min, expected and max values 
from the MSP file with no further user intervention. A progress indicator 
appears and a confirmation message is displayed once the task is finished. 

Click OK to complete the operation. The selected Tasks are added to the 
Uncertainty list and the 3PE parameters are displayed. 
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5.5 Uncertainty Driver Analysis   

 
Click once on the Uncertainty Driver Analysis Feature Bar control. The attached 
project will be minimised and the application will apply the Uncertainty 3PE 
assessments into the project and record the effects on the Key Output Task. 
 
Prerequisite:  please ensure there is at least one Uncertainty assessment in the 
Uncertainty Drivers list or the application will have no data to analyse. 
 

5.6 Quantitative  Conversion 

 
If you have used any form of Qualitative assessment it will necessary to covert 
Qualitative to a Quantitative value 

 Select Quantitative Conversion  from the Uncertainty function 

 Select All or pre select a row(s) from the viewing panel, use Ctrl+Click to 
select more than one row. 
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 Risk and Opportunity  
As far as the term Risk is used you may consider the word Opportunity to be 
exchangeable where the effect of the impact is of the opposite polarity. 
 
The differentiator between Risk (and Opportunity) and Uncertainty is the 
Probabilistic element – also known as Likelihood. 
 
In risk, for there to be a Likelihood of occurrence, recorded as Probability on a 
scale of 0% - 100%, there must be an associated event or root-cause for the 
impact to manifest 

 
 

 
 
Change pics 
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6.1 View 

 
 
Tool is Factory set at Unformatted view only 

6.2 Data 

 

 

6.2.1 Create a new risk  

 
To add a Risk Driver by manual entry, follow the following 3-point procedure: 
 
 
 
 
 
 
 
 

6.3 Create Risk Driver 

1. Click once on the Risk > Create New Risk control on the Risk and 
Opportunity Tab > Feature Bar. The Add Risk pop-up appears: 
 

R 
 

Create 
Risk 

Driver 

I 
 

Add 
Impact  

Driver 

P 
 

Make 
Parameter 

Assessment 
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a. Type the Risk Name (mandatory), 
b. Enter the Risk Code, if applicable (optional) 
c. Select the Risk Manager (optional) 
d. Enter a high-level Description of the risk (Optional) 

 
Click Save and Close. The Risk Driver is displayed in Risk Drivers List. 

6.3.1 Add an Impact to a Risk Driver 

On its own a Risk Driver has no effect on the analysis. It requires the application 
of at least one Impact Driver to describe its effect on the project model. Each 
Risk Driver may have an unlimited amount of Impact Drivers, each affecting a 
different task in the attached project. In this way it is possible to build-up 
complex effects of risk and opportunity and then measure their aggregate effect. 
 
 
To add an Impact Driver by manual entry: 
 

 
 In the Risk Drivers list pane select the Risk Driver row to which the Impact 

Driver is to be added by clicking once on the desired row. 

 Right-click once on the selected row and click on the Add Impact TASK 
selected control on the context menu that appears. 
 
 
 

Right Click 
Menu 
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 The target Task selection dialogue box will appear: 

 
 

 If you want to add a named range, select that option, click Select and 
then choose the named range that contains the cells to add as impacts. 

a. Select the task (or tasks) to which you want to add an impact. 
 

A confirmation message is displayed once the Impact is added is finished. Click 
OK to complete the operation. The impact is displayed in the Impact Drivers List 
pane. The Shape column is coloured red denoting an incomplete or incorrect 
parameter set. 

6.4 Make a Parameter Assessment on an Impact Driver 

To have an effect on the project during analysis an Impact Driver needs a 
Parameter Assessment to describe its effect on the project model. Each Impact 
Driver has one impact assessment that pertains to an individual project task. 
 
To add an assessment to an Impact Driver by manual entry: 

 In the Impact Drivers list pane select the Impact Driver row to which the 
Impact Assessment is to be added by clicking once on the desired row. 

 The Impact Assessment Parameters pane at the base of the Risk & 
Opportunity Function Tab now relates to the selected Impact Driver. 

 Set Probability: 

 Select either of the Qualitative or Quantitative options.  

  Select the desired Probability Level from the drop-down list that appears 
to the right of the option; 

 Quantitative: Type in the desired Probability value ( an integer between 
0 and 100) in the field that appears to the right of the option. 
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 Set Impact: 

 Select either of the Qualitative or Quantitative options.  

 Qualitative:  

 Select either Relative or Absolute levels; 

 the desired Impact Level from the drop-down list that appears to the right 
of the option; 

 Quantitative: 

 Select the desired Shape from the drop-down list that appears to the right 
of the option; 

 Type in the desired Impact Values (min, likely, max, etc) in the fields that 
appear underneath the shape drop-down. 

 Click Save. The Impact Driver Assessment parameters are displayed in the 
Impact Drivers List pane in their respective fields.  

 

: Any blank, inappropriate or illegal field values are highlighted in red. 

 
 Relative will produce values for min. most likely and max (3PE) based on 

the deterministic value used in the model. 

 Absolute option will add the deterministic value to the pre-determined 3 
PE defined by “User”. This option is best suited to “Design to cost” 
modelling when detailed risk impact information is limited. 
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6.5 Import risks from an external risk register 

 
To import risk data from an external risk register in an Excel workbook: 

 Ensure the external register is prepared and saved in the format shown on 
the following page. The red box denotes the mandatory name range RISKS: 

 Click once on the Risk and Opportunity Tab > Data > Import Parameters 

 Select the From external register (.xls) option.  

 Select the file name and location from the displayed file-browser window  

 Click Open. 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. The imported 
information is added to the Risk Drivers list and displayed in the main list. 

 
Notes: the task name is optional  

 Scatter or Blanket – scatter means all impacts of a risk instance are 
probabilistically independent – blanket means they are probabilistically 
linked. 

 Use either Probability Level (Qualitative) OR Probability (Quantitative)– 
not both. 

 Use either Impact Level (Qualitative) OR Min, Likely, Max (Quantitative)– 
not both. 

 Serial or concurrent defines risk interaction in modelling. 

 Include_Risk and Include_Impact can be used to switch-off whole risks or 
individual impacts during Monte Carlo simulation and analysis. 

LPHI has the same effect as Include_Risk but tags the risk so it can be treated 
separately in Monte Carlo Simulation, reporting and MIS. 
 

6.6 Export risks to an external risk register 

 
To export Risk data to an external register to a new Excel project: 

 Click once on the Risk and Opportunity Tab > Data > Export Parameters 

 Select the To external register (.xls) option.  

 Select the file name and location in the displayed file-browser window  

 Click Save. 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. 

 
The Risk data parameters are exported in the format described in Section 6.3: 
The parameters may be edited, extended or reduced as required in Excel and 
then re-imported into the application using the control: 
Risk and Opportunity Tab > Risk > Import Parameters > From external register 
(.xls) control. 

6.7 Quantitative  Conversion 
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If you have used any form of Qualitative assessment it will necessary to covert 
Qualitative to a Quantitative value 

 Select Quantitative Conversion  from the Uncertainty function 

 Select All or pre select a row(s) from the viewing panel, use Ctrl+Click to 
select more than one row. 
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 Analyse and Reports 
 

 
 
 
 

7.1 View 

 
 
The view function allows you select what is displayed in the key results viewing 
panel. 
 

 Duration Det. Value column will display Duration days 

 Total Cost  Det. Value column will display Total Cost. 

 Finish  Det. Value column will display Finish date 

 Start  Det. Value column will display Start Date. 

 Criticality Det. Value column will display Criticality Index number 

 First N A popup will ask you how many of the key results you would 
like to be displayed. 

 All  Will display All key results 

 Show project during Analysis will update MS Project will changes. This 
will increase the time taken for each simulation. 
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7.2 Data 

 

7.2.1 Add key results from Project 

 
Adding Key Results to the task list is done by selecting tasks from the attached 
project.  

 On the Feature Bar click once on the Data button. 

 Select Add key results from project the ‘Select Task’ dialog box will 
open and presents selection list 

 

 
 

 Select the tasks you want to add to the Key Results list. 

 Click OK. Tasks that are selected will be added to the list of Key Results.  

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 
 
Tip: You may select an individual cell, multiple cells, contiguous groups of cells 
or non-contiguous cells (using the Ctrl key). 
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: You may reduce the number of nugatory cells added to the Key Results 
list by checking this option before adding the selected cells. This can help make 
the subsequent simulation faster and the reports cleaner and less cluttered. 
 
 

7.3 Import Key Results to list  

The ability to import a list of Task references from an external excel workbook 
provides the ability to add desired Key Results negating the need to repeat the 
selection process where a list of Key Result cell references is known and saved. 
To import a list of Key Result cell references to Excel: 

 On the Feature Bar click once on the Data control 

 Select Import Parameters 

 Select From External Workbook (.xls) 

 Select file from popup dialog screen then Open 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 

7.3.1 Export Key Results 

The ability to export the list of cell references to an external excel workbook 
provides the ability to edit, maintain and subsequently import the whole list of 
selected Key Results, thus negating the need to repeat the selection process. 
To export the list of Key Result cell references to Excel: 

 On the Feature Bar click once on the Data control 

 Select Export Parameters then To External Workbook (xls)  

 Name the file from popup dialog screen then press Save 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 

 File format: 

 

7.3.2 Remove tasks from the key results list 

 
There are two options for removing Key Results directly from the list: 

 All 

 Selected 
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7.3.2.1 To remove all Key Results from the list 

 On the Analysis and Reports Feature Bar, click once on the Remove 
control and select the All option from the drop-down list.  

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 

7.3.2.2 To remove selected Key Results from the list 

 In the Key Results pane, first select the Key Result rows you want to 
remove from the list by clicking on each one.  

 You can use the shift or Ctrl keys to select ranges or non-contiguous rows. 

 On the Analysis and Reports Feature Bar, click once on the Remove 
control and select the Selected option from the drop-down list.  

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 

7.3.3 Add Key Results from Project 

 Although part the Data options this function tab has been added to 
improve your effectiveness by saving key stokes. On the Feature Bar click 
once on the Add key results from project tab, the ‘Select Task’ dialog 
box will open and presents selection list 

 

 
 

 Select the tasks you want to add to the Key Results list. 

 Click OK. Tasks that are selected will be added to the list of Key Results.  

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation. 
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: You may select an individual cell, multiple cells, contiguous groups of 
cells or non-contiguous cells (using the Ctrl key). 
 

7.3.4 Change key Output task 

 
 From analysis and reports section select the Change key Output Task tab.  

 Select the tasks from popup list you want to add to the Key Results list. 

 Click OK. Tasks that are selected will be added to the list of Key Results.  

 A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

 Click OK to complete the operation 
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7.3.5 Calculate theoretical limits 

The MS Project workbook is constructed using deterministic estimates, this 
function replaces the deterministic values with the 3 point estimates that fed 
the Hullograms with data so that the extreme values can be displayed on the 
graph. 

: It is important that this run before hullograms are prepared.  

7.3.6 Display Options 

 
 The Analysis results display can be changed to suit your requirements 

 Select the required percentage values and press Apply then Close. 

 By selecting  Default you can reset to “Factory settings”  
:   
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7.3.7 Decimal Places 

 
 The decimal places shown in the result displayed can be adjusted to level 

you require, this is useful when working in £k. 

 Input required value and press Apply then Close. 
 

7.3.8 Messages 

 
 Messages are useful to track progress or warn you of error, but they do 

slightly increase process time, this options allow you to change the 
frequency or turn then off completely.  

 Input record refresh rate  

 Un-tick box to switch off information messages then press Apply and 
Close. 
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7.3.9 Impact Colour 

 
 

 This options allows you to change the ‘Impact colour’ used . 

 Select required colour setting and press Apply then Close 

 The invert button will swop the ”increase” and “decrease” selections 
press Apply then Close 

 Default resets to “factory Settings” 

 

7.4 Analysis & Reports contextual menu 

(Right Click menu) 
 
This menu is assessed from the Key results viewing panel, from anywhere within 
the panel right click and the options menu will appear. 

 
 
 

7.4.1 Add Task 

This function is allows you to add a task via the “Select Task” 
menu. 

 From the popup menu select Add Task. 

 This will open the Select Task menu 

 Select task then press OK; for multiply choice use clrt key+ click then OK 
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7.4.2 Remove selected from key Results 

 Select the row you wish to remove. 

 Right click and Select Remove selected from key results 

7.4.3 Show Hullogram for selected 

 Select the Key results you wish to create a Hullogram. 

 Right click and select show Hullogram 
 

7.4.4 Create DDC (Custom Distribution)  

Create DDC (Custom Distribution): Will create a .ddc file describing a custom 
distribution based on the 0%-100% statistical output of the task’s duration. This 
may be used as an input distribution to other tasks or in the Excel version of the 
Arrisca application as a ‘Custom Distribution’ input. 
 

 Select Key result row. 

 Right click and select create DDC. 

 Name file and press OK. 
 
 

7.5 Simulation 

The application enables the user to run a meta modelling technique to simulate 
the effects of the stochastic variables, risk and uncertainty, on the workbook. 
The modelling technique used is called Monte Carlo simulation. The results of 
this simulation can be analysed to generate statistical information regarding the 
ranges of outturn of the workbook to inform the decision-making process. 
 
Whilst the simulation itself is a complex computing exercise the controls 
presented to the user are simple and straightforward. They are located in the 
bottom left of the Analysis & Reports Function Tab. 
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: To be able to run a Monte Carlo simulation the model must contain at 
least one element of either uncertainty or risk or there will be nothing to 
analyse. 
 

7.5.1 Run a new simulation set 

If the system has not yet run a simulation there is only one option available, the 
New Simulation button. 
 

 
 
To initiate a Monte Carlo simulation: 

 Type in the number of simulation iterations required in the No. of 
iterations data entry field to the right of the button. 

 Chose if you require to include or exclude low probability high impact 
(LPHI) risks 

 Chose Mode - Standard will produce data suitable for good quality 
graphical and output data. Whereas Standard+ Hi Definition will provide 
data that will enable high quality graphs to be produced also the data for 
each simulation is available that records which risk are active and any 
given point.   

 Chose to include exclude CCI calculations. 

 Click once on the green New Simulation button. 

 The workbook will be hidden and the simulation will begin. 

  
The Stop Simulation button is displayed- this will abort the process.  
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 During simulation a progress indicator is displayed to track the simulation 
iterations as they are completed. An estimated time to complete is also 
displayed along with the current elapsed simulation time. 
 

 
 

 The workbook is redisplayed once the simulation is finished and the 
statistical outcome values are displayed in the Key Results pane. The 
simulator controls now display the green New Simulation and Continue 
Simulation buttons. 
 

 
 

7.5.2 Continue a simulation set  

If the system has run a simulation you may want to continue the simulation from 
where it ended to generate more iteration data and improve the quality of the 
results. To continue a simulation set: 

 Type in the new number of simulation iterations required in the No. of 
iterations data entry field to the right of the button. 

 Click once on the green Continue Simulation button. 

 The workbook will be hidden and the simulation will continue.  

 The simulation will run until either the Stop Simulation button is clicked 
or the new No. of iterations limit is reached. 

7.5.3 Stop a simulation set  

If the system has run a simulation you may want to continue the simulation from 

 Click once on the green Stop Simulation button. 

 At the end of the next set of slices the simulation will end. 

 The workbook is redisplayed once the simulation is finished and the 
statistical outcome values are displayed in the Key Results pane. The 
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simulator controls will now display the green New Simulation and 
Continue Simulation buttons again. 

7.5.4 SEED option 

 
 
The seed option allows you to use either a Random number or a Fix Seed. 
 

:Use fixed if wish to repeat a simulation that will give identical results 
each time it is run. 

7.5.5 Convergence 

 
With any statistical simulation technique you reach a point when more 
simulations runs will not improve the output results, this option allows you set 
the point at which you consider the simulation should stop. 
 

7.5.6 Stop a simulation set  

If the system has run a simulation you may want to continue the simulation from 

 Click once on the red Stop Simulation button. 

 At the end of the next set of slices the simulation will end. 

 The workbook is redisplayed once the simulation is finished and the 
statistical outcome values are displayed in the Key Results pane. The 
simulator controls will now display the green New Simulation and 
Continue Simulation buttons again. 
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 Reports 

 

8.1 Graphical 

8.1.1 Hullogram 

Hullogram will produce an s-curve graph in Excel based on either: duration, 
finish date or Total Cost 
 

 Select graph option 

 A process message box will indicate when task is complete 

 Use Excel to view output. 
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8.1.2 Hi Definition 

Press Hi Definition S-curve with risk occurrences for very detail graphical 
output, with data points for each simulation that also records the impact 
value of each risk at that point 

 

 
 

 

8.1.3 Scatter 

Will produce a plot of Duration vs Cost or Finish Date vs Cost 
 

 In the Scatter section select graph option 

 A process message box will indicate when task is complete 
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 Use Excel to view output. 

 

8.1.4 General  

A risk-adjusted view of the project plan may be easily produced (post simulation) 
for the Key Output Task, by selecting the Risked Gantt report: 

 Risked-Gantt of the original project plan 

 Convergence: Will produce a convergence graph at the 10%, 50% & 90% 
 

8.2  Drivers 

 
A sensitivity report in Excel can be produced from the Drivers section of the 
reports. 
 

 From the Drivers section select the report content from the dropdown 
output menu 
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 Tick filter box if you wish to report by Risk Category  

 Select category, for multiple selections use Clrt+Click and press Apply 

 
 Press Sensitivity Driver Report  link. 

 A message box will inform you when complete. 
 

 
 

8.3  Uncertainty 

A Uncertainty report in Excel can be produced from the Uncertainty section of 
the reports. 
 

 From the Uncertainty section select the report content from the dropdown 
output menu. 

 
 Tick filter box if you wish to report by Risk Category  

 Select category, for multiple selections use Clrt+Click and press Apply. 
These will be displayed next to category box. 
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 Press Uncertainty Driver Report link. 

 A message box will inform you when complete. 
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8.4  Risks 

A Risks report in Excel can be produced from the Risk section of the reports. 
 

 From the Risks section select the report content from the dropdown 
output menu. 

 

 
 Tick Include LPHI risks if required. 

 Tick filter box if you wish to report by Risk Category  

 Select category, for multiple selections use Clrt+Click and press Apply 
These will be displayed next to category box. 

 
 Press Uncertainty Driver Report link. 

 A message box will inform you when complete. 
 
View of Risk output report, that also contains Tornado graphs. 
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8.5 Key results 

A key report in Excel can be produced from the Key results section of the 
reports. 
 

 From the Key results section select the report content from the dropdown 
output menu. 

 
 Press Key results Report link 

 A message box will inform you when complete. 

8.6 General reports 

 

There are 4 options in the general section: 

Full Report 

 This feature can be used to package and export the primary 
assessment data and output results to an Excel workbook. 
The workbook contains:  

o The description of the Project workbook and its primary attributes  
o The complete range of outcomes of the analysis as described by an 

S-curve in 5% confidence level increments 
o The complete graphical outputs 
o The complete collection of: 

 sensitivities,  
 uncertainty,  
 risks, opportunities  
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 associated Input Parameters and resulting Impact data 
 associated categorisation and classification information 
 Risk ownership information 

LPHI  
 This will produce an Excel workbook that lists all the elements that you 
have selected as low probability High Impact risks. 
 
Browse Existing Reports 
 Will open an existing Excel report 
 
Browse Existing Graphs 
 Will open an existing Excel workbook with graphical outputs 

 The browse functions have been included to save you leaving the Arrisca 
program to establish what report names have been used. 
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 Main Menu  

9.1 File 

 
 

9.1.1 Open New spreadsheet 

This option will take you to the specified folder and allow you to open a new 
spreadsheet. 

9.1.2 Reopen Current Spreadsheet 

If the workbook that is being analysed gets closed for some reason either 
intentionally (because the user wants to discard all changes) or by accident this 
command will automatically reopen the current spreadsheet for you. 

9.1.3 Refresh Current Spreadsheet 

This command is used to update the Arrisca software with any changes that may 
have been made to the structure, formulas or constants in the spreadsheet. If 
the spreadsheet has been modified by the user whilst it has been open with 
Arrisca the spreadsheet must be first saved and then this command to update 
Arrisca with the changes. 

9.1.4 Save PAF file 

This allows you to save both Arrisca inputs/outputs and the Project sheet in one 
file. 

 This file is a compressed archive and contains the following elements: 
Source project plan (.mpp) (that can be redeployed when the archive is 
reopened on another machine at a later date), 

 Arrisca-related data and parameters 
o Drivers 
o Uncertainty 
o Risks & Opportunities 
o Analysis & Reports 
o All user inputs / outputs and associated comments 
o Associated risk and uncertainty registers 
o All analytical results and reports which can be immediately 

accessed. 
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  : This provides an excellent method for creating an archive document 
that as well containing the results of the analysis also contains a frozen copy of 
the Excel workbook that the analysis was based on.  

9.1.5 Open PAF file 

Will open a PAF file so that the Arrisca tool is populated and the associated 
Project file is opened. 

9.1.6 Exit Application 

 
 
When Exit or Close application is selected the close down menu is displayed, this 
gives you the option to: 

 Save – save file without renaming 

 Save As- save as a new file 

 Don’t save – any changes are lost 

 Cancel – skip shut down 

9.2 Edit 

 
 

9.2.1 Qualitative Settings 

The Qualitative assessments that are possible in Arrisca Velocity use Qualitative 
Assessment Level Definitions to provide parameter sets for analysis.  
The Levels are accessed from the Main Menu select Edit > Qualitative Settings  
This displays the Edit Levels Function Tab as shown below: 
 
The default level definitions are as follows: 
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9.2.2 Probability Levels 

 

 

9.2.3 Relative Risk/Opp Impact Levels 

 

 
 

9.2.4 Absolute Risk/Opportunity Impact Levels 
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9.2.5 Relative Uncertainty Levels 

 

  

9.2.6 Level management and configuration 

All the Edit levels can be changed or added too via the right hand data panel: 

 Changes, select the row you wish amend and update the associated 
metadata use Save to store data  

 New, select New input description, then use Assessment to define the 
impact or probability; Order by refers the order the content will be 
displayed in the dropdown menu 

 

9.2.7 Type Settings (Risk and Drivers) 

 
 

 Status- Risk term to describe the life cycle of the risk and will be defined 
in risk management process  

 Severity-Impact of the risk; these are defined by your Organisation’s risk 
management process 

 Category (for Risk)- The part of business that effected by the risk; this 
defined by risk management process. 

 Risk Level- The ranking of risks by their effect; the number of risk levels 
will be defined in risk management process. 

 Classification- What type of risk is it can it be grouped with other risks 
e.g. By Cost impact, by Time, etc, these will be defined in risk 
management plan. 

 Phase Type- describes when the risk is likely to occur. For an ISO 15 288 
company this the CADMID phases.   

 Driver Category-  What part of the Business or process is affected e.g. 
Wage rates, Material, Testing, etc 
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9.2.8 Type Settings management and configuration 

 
 All Type settings can be changed or added too via the right hand data 

panel: 

 Changes, select the row you wish amend and update the associated 
metadata use Save to store data 

 New, select New input description and associated data and press Save. 
Order by refers the order the content will be displayed in the dropdown 
menu 
 

9.2.9 User Information 

 
 
This provides a method of controlling data and providing an audit trail. It will 
require the risk management plan to define Users limitations.  
 

 Users can be changed or added too via the right hand data panel: 

 Changes: select the row you wish amend and update the associated 
metadata use Save to store data 

 New, select New input details and press Save. Order by refers the order 
the content will be displayed in the dropdown menu 
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9.2.10 User-Custom Distributions 

 
 
This feature allows you to add a custom distribution, this may be data from a 
previous project that best describes a possible outcome if a risk occurs. 
 
Create distribution 

 Select New from data input panel, fill in the blank metadata cells Name, 
Order (default =1) and Active are mandated inputs others are optional. 

Distribution data input 

 The shape of the distribution is described by an outcome value and the 
point at it occurs (Cumulative_Prob). The Outcomes must be a 
progressive value and the Cumulative probability must also be progressive 
with a range of 0 to 1. A maximum of 21 data points are allowed; press 
Save.  

 Once entered the distribution can viewed in Excel by selecting the Show 
Shape in Excel button (see above). 

 Plots can be amended in Excel 

 Change cumulative prob or outcomes. 

 Press Validate button in workbook to check that data conforms. 

 Return to Arrisca and select Retrieve shape from Excel button 
 

 Press Save to store shape. 
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9.3 Tools 

 

9.3.1 Purge all inputs and results data 

After several runs of the software certain internal computer memory devices will 
need to be reset to eliminate inconsistent results, select this option to clear 
memory. 

9.3.2  Global Import 

 

9.3.2.1 From External Register (.xls) 

 Enables a saved formatted risk register to be imported and used as a 
template for a new workbook 

9.3.2.2 Import Levels 

 Import risk levels from .xlm file 
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9.3.2.3 Import Custom Shape 

 Import custom shape  from Excel workbook  

9.3.2.4 Configuration Settings 

 To maintain constancy of approach you can import a saved configuration 
from an earlier task via a .xlm file.  

9.3.2.5 Load Default Types 

 Reset to “Factory supplied” values 
 

9.3.2.6 Load Default Qualitative Levels 

 Reset “Factory Supplied” values 

9.3.2.7 Import DDC (custom distribution) 

The Arrisca software allows you create DDC file which captures a distribution 
from a previous analysis and may represent a input distribution for a new analysis 

 From the Tools tab on the main menu select Import DDC (Custom 
Distribution)  

 Select the required file from the Import Custom Distribution popup. 

 A popup will confirm the file has been imported, Press OK.   
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9.3.3 Global Export 

 

9.3.3.1 Export to External register (.xls) 

 

9.3.3.2 Export Levels to Excel  

 Saving the custom Levels will you to reuse Levels for similar tasks. 

9.3.3.3 Export Custom shape to Excel  (.xls) 

 Saving Custom Shapes allows reuse for other tasks 

9.3.3.4 Export Configuration Settings  

 Saving Configuration settings allows reuse for other tasks 
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9.3.4 Manage Display Options 

 

9.3.4.1 Percentiles Columns  

 
 The Analysis results display can be changed to suit your requirements 

 Select the required percentage values and press Apply then Close. 

 By selecting  Default you can reset to “Factory settings”  
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9.3.4.2 Decimal Places 

 
 The decimal places shown in the result displayed can be adjusted to level 

you require, this is useful when working in £k. 

 Input required value and press Apply then Close. 
 

9.3.4.3 Messages 

 
 Messages are useful to track progress or warn you of error, but they do 

slightly increase process time, this options allow you to change the 
frequency or turn then off completely.  

 Input record refresh rate  

 Un-tick box to switch off information messages then press Apply and 
Close. 
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9.3.4.4 Impact Colour 

 
 This options allows you to change the ‘Impact colour’ used . 

 Select required colour setting and press Apply then Close 

 The invert button will swop the ”increase” and “decrease” selections 
press Apply then Close 

 Default resets to “factory Settings” 

9.3.5 Automation 

 
 The Arrisca software can be run automatically by dragging the Excel 

workbook over the Arrisca Desktop icon. However, for this to function to 
work the workbook must be constructed in particular format. 

 Load spreadsheet Template  

 Run Template 

 Add Template to this Workbook- 

9.3.5.1 Load Default Application Settings 

 

 Select this option to reset all levels, Category’s and Classification’s to 
“Factory setting”. 
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9.3.6 Distribution Explorers 

 
 The explorer tool allows you picture the distributions based on a Normal 

and Log Normal basis. 

 Select which option Normal or Log Normal an Excel workbook will open, 
there are only 2 inputs required Desired mean and number of Standard 

Deviations  

: The use of a log normal can have a significant effect in that it 
concentrates impacts at the lower end of the probability scale but 
extreme high impacts compared to a normal distribution. It should only 
be used when there evidence to justify its use. 

9.3.7 Refresh Screen 

 This is a standard refresh function use when display’s get over written 
with spurious data. 

9.3.8 View & Browse Data Area 

 This function will start the Windows Explorer and take you straight to the 
folder where you have stored files. 

9.3.9 Reset Data Area 

 This will reset all data area and restart software.  

: Use with caution as Arrisca will shut down and your data may 
be lost. 

9.3.10 Simulate Crash 

 The simulate crash function is to provide you with confidence in the 
Arrisca’s capability to capture your inputs as you progress through the risk 
analyse assessment (sensitivity, uncertainty, etc). 

: Use this to demonstrate the Arrisca’s tool robustness. 
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9.4 Help 

 

9.4.1 About riskHive Analyser 

 Will display the issue, build state release date and contact information 

9.4.2 EULA 

 Will display a copy of the software licence agreement. 

9.4.3 Documentation and Guides 

 Will link you the riskHive Web site where you can access online help files 

9.4.4 Event Log 

 Will display in MS Note a recorded of all the error logs created for the day. 

9.4.5 Licensing and upgrades 

 Will link you the riskHive Web site where you can obtain information 
regarding licensing and upgrade keys 

9.4.6 Enter upgrade key 

 Input new upgrade key code 
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TaskUnique ID

Task Name

Code

Risk Name

Risk notes

Scatter_or_blanket

Probability Level

Probability

Impact Level

Minimum

Likely

Maximum

Shape

Whole

Serial_or_concurrent

Include_risk

Include_impact

Impact notes

Register

LPHI

Manager

Status

Severity
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Level

Classification
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 Excel Risk Register Format          
 

  Field Format Required/Optional 

TaskUnique ID number Required 

Task Name Text Optional 

Code Text Optional 

Risk Name Text Required 

Risk notes Text Optional 

Scatter_or_blanket S OR B Required 

Probability Level Text Optional 

Probability 
Number 1-

100 
Required 

Impact Level Text Optional 

Minimum Number Required 

Likely Number Required 

Maximum Number Required 

Shape Text Optional 

Whole True\False Optional 

Serial_or_concurrent S OR C Required 

Include_risk True\False Required 

Include_impact True\False Required 

Impact notes Text Optional 

Register True\False Optional 

LPHI True\False Optional 

Manager Text Optional 

Status Text Optional 

Severity Text Optional 

Category Text Optional 

Level Text Optional 

Classification Text Optional 

Objective Text Optional 

Phase Text Optional 
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 Support 
 
 
Your appointed reseller is: 
 
riskHive Ltd. 
Dilkush 
Farlers End 
BS48 4PG 
 
Tel:  +44 (0)117 373 1100 
Fax: +44 (0)117 373 1103 
www.riskHive.com 
 
Support 
 
Support service: Via the ‘feedback & support’ online service. It will keep you 
posted on the progress of your enquiry  
 

 
 
Alternatively 
 
email: support@riskhive.com 
 
Phone +44(0)117 373 1100 
 
Support lines are open from 09:00 to 17:30 (GMT) Monday to Friday. 
 
General enquiries email: info@riskhive.com 
 
 

http://www.riskhive.com/
mailto:support@riskhive.com
mailto:info@riskhive.com

